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Quartus Prime — projekt wzorcowy

1. Pierwszym krokiem przy zaktadaniu nowego projektu w programie Quartus Prime jest zatozenie nowego
katalogu, w ktédrym beda znajdowaty sie wszystkie jego pliki. Sciezka dostepu do katalogu nie moze zawieraé
w sobie znakoéw spacji oraz polskich znakéw diakrytycznych (np. 3, €, §, itd.).

2. Do katalogu projektu nalezy skopiowac wskazany plik z rozszerzeniem gsf, ktoéry wigze nazwy symboliczne
pindw wejscia/wyjscia uzywanych w projekcie z fizycznymi pinami uktadu FPGA.

3. Uruchomi¢ program Quartus Prime i otworzy¢ kreator tworzenia nowego projektu z okna powitalnego
Creave a New Project (New Project Wizard) lub File -> New Project Wizard... Pojawi sie okno
New Project Wizard (Rys. 1). Klikamy przycisk Next.

(O New Project Wizard X

Introduction

The New Project Wizard helps you create a new project and preliminary project settings, including the

following:

* Project name and directory

* Name of the top-level design entity
* Project files and libraries

* Target device family and device

* EDA tool settings

You can change the settings for an existing project and specify additional project-wide settings with the
Settings command (Assignments menu). You can use the various pages of the Settings dialog box to add
functionality to the project.

O Don't show me this introduction again

< Back Finish Cancel Help

Rys. 1: Okno Wizard nr 1
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4. W kolejnym oknie (Rys. 2) wskazac¢ jako lokalizacje projektu utworzony wczeséniej katalog oraz podaé nazwe
projektu. Nazwa nie moze zawierac znakdw spacji oraz nie moze zaczynac sie od cyfry. Klikamy przycisk Next.

(O New Project Wizard X
Directory, Name, Top-Level Entity
What is the working directory for this project?
|E/FPGA/Dydakiyka/Prolab] |-
What is the name of this project?
‘ProLahO_Fundamemals
What is the name of the top-level design entity for this project? This name is case sensitive and must exactly
match the entity name in the design file.
‘ProLabO_Fundamentals
Use Existing Project Settings...
< Back Finish Cancel Help
Rys. 2: Okno Wizard nr 2
5. W kolejnym oknie (Rys. 3) nalezy wybrac pusty projekt.
(O New Project Wizard X
Project Type

Select the type of project to create.

® Empty project
Create new project by specifying project files and libraries, target device family and device, and EDA tool

settings.
O Project template

Create a project from an existing design template. You can choose from design templates installed with
the Quartus Prime software, or download design templates from the Design Store.

< Back Finish Cancel Help

Rys. 3: Okno Wizard nr 3
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6. W kolejnym oknie (Rys. 4) mozna dotgczy¢ do projektu zewnetrzne (wczesniej utworzone) pliki. W takim
przypadku zaleca sie, aby wczesniej zostaty one skopiowane do katalogu projektu. Jesli nie dodajemy nowych
plikéw klikamy Next.

(O New Project Wizard X
Add Files
Select the design files you want to include in the project. Click Add All to add all design files in the project
directory to the project.
Note: you can always add design files to the project later.
File name: | Add
. %] add Al
File Name Type Library Design Entry/Synthesis Tool HDL Version Remove
Up
Down
Properties
Specify the path names of any non-default libraries. \User Libraries...
< Back Finish Cancel Help
Rys. 4: Okno Wizard nr 4
7.

Nastepnie nalezy wybrac¢ rodzine uktadu FPGA oraz uktad znajdujgcy sie na ptycie DE10-Lite. Rodzine oraz
uktad mozna odczytaé z uktadu FPGA, pudetka lub dokumentacji producenta ptyty DE10-Lite.

G New Project Wizard

Family, Device & Board Settings

Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.
To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Available devices' list

Family: |MAX 10 (DA/DF/DC/SA/SC) e Package: Any =

Device: = Pin count Any &

Target device Core speed grade: |Any ¥
Auto device selected by the Fitter Name filter:

® specific device selected in 'Available devices' list Show advanced devices

Other: nfa

Available devices:

Na/;ne Core Voltage LEs Total 1/Os GPIOs y Bits 9-bitel
10MDODAF484C8G 1.2V 49760 360 1677312
___
10M50DAF484C6GES 1.2V 49760 360 1677312 288
10M50DAF25617G 1.2V 49760 178 178 1677312 288 v
< >

< Back Einish Cancel Help

Rys. 5: Okno Wizard nr 5
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8. Kolejne okno pozwala na ustawienie zintegrowanych narzedzi pomocniczych do analizay, syntezy oraz

symulacji. Catos¢ pozostawimy bez zmian, klikamy przycisk Next.

G New Project Wizard

EDA Tool Settings

EDA tools:

Specify the other EDA tools used with the Quartus Prime software to develop your project.

Tool Type Tool Name

Design Entry/s. <None>

Simulation <None>
Board-Level Timing
Symbol

Signal Integrity

Boundary Scan

1

1

Format(s)
<None>
<None>
<None>
<None>
<None>

<None>

Run Tool Automatically

Run this tool automatically to synthesize the cu

Run gate-level simulation automatically after compilation

ent design

< Back Finish

Cancel

Help

9. Ostatnie okno kreatora to podsumowanie. Jesli wszystkie parametry s zgodne z zaktadanymi, klikamy

przycisk Finish.

Rys. 6: Okno Wizard nr 6

G New Project Wizard

Summary

Project directory:
Project name:
Top-level design entity:
Number of files added:
Number of user libraries added:
Device assignments:
Design template:
Family name:
Device:
Board:
EDA tools:
Design entry/synthesis:
Simulation:
Timing analysis:
Operating conditions:

Core voltage:

Junction temperature range:

‘When you click Finish, the project will be created with the following settings:

E:fFPGA/Dydaktyka/ProLab0
ProLab0_Fundamentals
ProLabO_Fundamentals

(o]

0

nfa
MAX 10 (DA/DF/DC/SA/SC)
10M50DAF484C7G

nfa

<None> (<None>)

<None> (<None>)

0
1.2V
0-85°C

Cancel

Help

Rys. 7: Okno Wizard nr 7
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10. Po skonczonej pracy kreatora zaktadania projektu, powinno ukazaé sie puste okno programu Quartus Prime

(O Quartus Prime Standard Edition - E/FPGA/D; ab0/ProLabO_f - ProLab0_f - X
File Edit View Project Assignments Processing Tools Window Help .
‘0m H + M0 D C | |protabo Fundamenals ~| < # S DT> ¥ KL S &V @

Project Navigator |\ Hierarchy same

4 MAX 10: 10M50DAF484C7G
* ProLab0_Fundamentals &

Tasks Compilation vl=e

Quartus Prime

lard Editio

Task
v P Compile Design
> P> Analysis & Synthesis
> P> Fitter (Place & Route)
> B Assembler (Generate programming filt
> B Timing Analysis .
>

~

Quartus Prime Tcl Console
tob

A (@[] 4] [¥ <cFitter>> | 88 Find.. | [88Findnext|

Tvoe ID Messade
© 253020 Default device 10MOBDAF484C8G is automatically selected for the device family MAX 10

e[ SEe

System (1) Processing

0%  00:00:00

Rys. 8: Okno programu Quartus Prime

11. Kolejnym krokiem jest dodanie do projektu pliku schematu blokowego. W tym celu nalezy wybraé
File -> New, a nastepnie Block Diagram/Schematic File (Rys. 9).

i@ New X

MNew Quartus Prime Project A

¥ Design Files

AHDL File

Block Diagram/Schematic File

EDIF File

Qsys System File

State Machine File

SystemVerilog HDL File

Tcl Script File

Verilog HDL File

VHDL File
¥ Memory Files

Hexadecimal (Intel-Format) File

Memory Initialization File
v Verification/Debugging Files

In-System Sources and Probes ...

OK H Cancel H Help

Rys. 9: Okno New file
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12. W gtdwnym oknie programu Quartus Prime pojawi sie pusty schemat blokowy (Rys. 10). Nastepnie nalezy
zapisac plik File -> Save As... nadajac mu odpowiednig nazwe np.: Top.bdf. Na tym etapie nowo utworzony
i zapisany plik powinien pojawi¢ sie w zaktadce Files projektu. Ostatnim krokiem jest poinformowanie
kompilatora, iz jest to plik nadrzedny w projekcie. Dokonuje sie tego poprzez wybranie opcji
Set as Top-Level Entity z menu pojawiajacego sie po kliknieciu prawym przyciskiem myszy na pliku.

(b Quartus Prime Standard Edition - E/FPGA/Dydaktyka/ProLab0/ProLab0_Fundamentals - ProLab0_Fundamentals
File Edit View Project Assignments Processing Tools Window Help

Or r ProLab0_Fundamentals ~ < & & < PEFES @AVE
Project Navigator ] Fites ~leme | T Top.bdf a
Files - r BRAwWADR-OITINNNOSNN[FEI A S £
& Topbdf 2
[Tasks Compilation v =lnex
Task <
v P Compile Design
P> Analysis & Synthesis
P> Fitter (Place & Route)
D> Assembler (Generate programming fil¢
P Timing Analysis " "
< > |« >
* |Quartus Prime Tcl Console
8 |
fi
2
fi

voe ID
© 253020 Default device 10MOSDAF484C8G is automatically selected for the device family mAX 10

[Messages

System (1) Processing

Rys. 10: Pusty schemat blokowy w programie Quartus Prime

13. Podstawowe elementy, z ktérych mozina zbudowac¢ schemat znajdujg sie
Symbol Tool (Rys. 11).

G Quartus Prime Standard Edition - E/FPGA/Dydaktyka/ProLab0/ProLab0_Fundamentals - ProLab0_Fundamentals

File Edit View Project Assignments Processing Tools Window Help

po

437,1 0%  00:00:00

kliknieciu na przycisk

O r Prolab0 Fundamentals ~ ~ & 4 T r F E S @ LD R
Project Navigator El Files ~ape x| % Top.bdf [x]
Files = r B rhkQWATE~-O"11INNSNSOON N [HIH A €4t

E? Topbdf

- | symbol Tool

Rys. 11: Symbol Tool
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14. Aby zbudowa¢ najprostszy projekt nalezy wybrac jedng z dostepnych bramek logicznych (Rys. 12).

* Symbol X

Libraries:

v & cfintelfpga/18.1/quart. »
B megafunctions
& others
v & primitives
& buffer

v & logic
£ and12
£ and2
& and3

& and4 N
< >

Name:

Repeat-insert mode

] Insert symbol as block

Rys. 12: Okno Symbol Tool

15. Kolejny krok to dodanie portéw wejscia/wyjscia znajdujgcych sie pod przyciskiem Pin Tool (Rys. 13).

O Quartus Prime Standard Edition - E/FPGA/Dydaktyka/Prolab0/ProLab0_Fundamentals - ProLab0_Fundamentals

File Edit View Project Assignments Processing Tools Window Help

OFH nim ProLabo_Fundamentals ~| < & E 5 T r F E S @A DR
Project Navigator E Files ~lame = T Top.bdf* (%]
Files H & | i) E k@ WwACEAO T 1 INNSNOoN N[ a S48

EA Top.bdf B Input

‘® Output
o

Rys. 13: Pin Tool
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16. Na tym etapie okno programu powinno przypominaé¢ to przedstawione na Rys. 14. Po nadaniu pinom

odpowiednich nazw symbolicznych (np.: SW[0], SW[1] jako wejscia oraz LEDR[O] jako wyjscie) projekt jest
gotowy do przeprowadzenia analizy i syntezy. W tym celu nalezy klikng¢ na przycisk
Start Analysis & Synthesis znajdujgcy sie na pasku lub wybraé¢ Processing -> Start ->
Start Analysis & Synthesis. Na tym etapie prawidiowo zbudowany projekt powinien by¢ bez bteddéw i

ostrzezen.

(O Quartus Prime Standard Edition - E/FPGA/D

oLab0/ProLab0_F

- Prolab0_F

File Edit View Project Assignments Processing Tools Window Help

O d D"

ProLab0_Fundamentals

Project Navigator = Files

vanex

Files
&2 Top.bdf

[Tasks Compilation

v=lnex

Task
v P Compile Design
P Analysis & Synthesis
B> Fitter (Place & Route)
B Assembler (Generate programming fils
P Timing Analysis
< >

v

Jrese

=

]

-

PFES OLADE
Top.bdf* %]

DRC[ERa¥AcE-O17INNNOo NN EEaz L

* |quartus Prime Tcl Console
P

Al (O 4] |4

wie

S —

88 Find.. | 88 Find Next

Twoe ID Messaae

D
© 253020 Default device 10MOBDAF484C8G is automatically selected for the device family MAX 10

[Messages

System (1) Processing

630,140 0%  00:00:00

Rys. 14: Okno programu Quartus Prime z bramkq AND2.

17. Nastepnie nalezy zaimportowac przypisania symboliczne pindw znajdujgce sie w skopiowanym wczesniej do

katalogu projektu pliku gsf. Assignments -> Import Assignments... Czynnos¢ te nalezy wykonac tylko raz w
czasie budowania projektu.

O Import Assignments

Specify the source and categories of assignments to import.
File name: |E:fFPGAnydakt}fkafProLabeDE'IG_Lite.qsf

Copy existing assignments into ProLab0 Fundamentals.qsf.bak befare importing

| | | Categories...

Advanced..

OK Cancel Help

Rys. 15: Okno Import Assignments
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18. Jedli dotychczasowe kroki przebiegty poprawnie przy portach schematu blokowego powinny pojawic sie
informacje o numerze pinu fizycznego uktadu FPGA (Rys. 16).

(O Quartus Prime Standard Edition - E/FPGA/D: ab0/ProlabO | - ProLab0f s X
File Edit View Project Assignments Processing Tools Window Help
O n» ProLabo_Fundamentals = <~ &€ &2 @ L DAV R
Project Navigator clame < | Top.bdf B @ Compilation Report - ProLab0_Fundamentals
Files =] D" BraQWAoRE~-O 11NN NOoN N [HIgEMA 2 &
&3 Topbdf . . . - : = -
> LEDR[O.
[Tasks Compilation r|=lie =
Task «
v B Compile Desigr
|a% > A synthesis
> e & Route)
ssembler (Generate programming filc
P Timing An . .
< > |« >
= [Quartus Prime Tcl Console
& |t
i1
?
[] .
i1
=|[Tvoe ID Messaae
o
o Running Quartus Prime Analysis & Synthesis
o Command: quartus_map --read_settings_files=on --write_settings_files=off ProLab0_Fundamentals -c ProLabO_Fundamentals
i 18236 Number of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PARALLEL_PROCESSORS in your QSF to an appropriate valu
©® 20030Parallel compilation is enabled and will use 4 of the 4 processors detected
2« >
i System (2)  Processing (5)

593,105 4% »¢ 00:00:08

Rys. 16: Okno programu Quartus Prime

19. Przed kompilacjg pozostato jeszcze ustawienie nieuzywanych portéw uktadu FPGA w stan wysokiej

impedancji. Assignments -> Device : Device and Pin Options : Unused Pins : Reserve all unused pins: As
input tri-stated (Rys. 17).

G Device and Pin Options - ProLab0_Fundamentals x
Category:
General | nusedpis |

Configuration

Specify device-wide options for reserving all unused pins on the device. To reserve individual dual-
Programming Files

purpose configuration pins, go to the Dual-Purpose Pins tab. To reserve other pins individually, use the
Unused Pins Assignment Editor.

Dual-Purpose Pins -

Capacitive Loading Reserve all unused pins: | As input tri-stated 2
Board Trace Model

/O Timing

Voltage

Pin Placement

Error Detection CRC

CvP Settings

Partial Reconfiguration

Description:

Reserves all unused pins on the target device in one of 5 states: as inputs that are tri-stated, as outputs
that drive ground, as outputs that drive an unspecified signal, as input tri-stated with bus-hold, or as
input tri-stated with weak pull-up.

Reset

OK Cancel | Help

Rys. 17: Okno Device and Pin Options
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20. W celu uruchomienia kompilacji projektu nalezy klikng¢ na przycisk Start Compilation lub wybraé
Processing -> Start Compilation (Rys. 18).

Ok Quartus Prime Standard Edition - E:/FPGA/D:

ab0/ProLab0 |

File Edit View Project Assignments Processing Tools Window Help

- ProLab0_f

D  nfllo) ProLabo_Fundamentals ~| “ € E ¢ T FES @AV R
Project Navigator E Files vlame < T & Compilation Report - ProLabo_Fundamentals & & DE10_Liteqsf
" Files (=] D" =) AV ATER~-O 11NN NDo N N g a g i
& Topbdf : : : <
Sl gﬂg;!:ib e e
ITasks Compilation MEI T
Task «
v P Compile Design
P Analysis & Synthesis
P Fitter (Place & Route)
B> Assembler (Generate programming filt
P Timing Analysis o o
< > |« >
= [Quartus Prime Tcl Console
A
i1
2
[=] o
i1
=|Twe ID Messaae ~
° 2 +
o Running Quartus Prime Analysis & Synthesis
o Command: quartus_map --read_settings_files=on --write_settings_files=off ProLab0_Fundamentals -c ProLabO_Fundamentals
& 18236 Number of processors has not been specified which may cause overloading on shared machines. Set the global assignment NUM_PARALLEL_PROCESSORS in your QSF to an appropriate va
@ 20030Parallel compilation is enabled and will use 4 of the 4 processors detected
n © 12021 Found 1 design units, including 1 entities, in source file top.bdf o
Bl 35137 c ke deden M e b e Taend s
2« >
i System (3)  Processing (12)

@

tarts a new compilation

174,-3 100%  00:00:16

Rys. 18: Okno programu Quartus Prime przed kompilacjg

21. Jesli kompilacja zakonczyta sie sukcesem mozna przystgpi¢ do zaprogramowania uktadu FPGA. W tym celu
nalezy wybrac przycisk Programmer znajdujacy sie na pasku lub Tools -> Programmer. Pojawi sie okno jak na

Rys. 19. Nastepnie nalezy klikng¢ na przycisk Add File... i z podkatalogu output_files wybrac¢ plik z
rozszerzeniem *.sof.

& Programmer - E;/FPGA/Dydaktyka/ProLab0/ProLab0_Fundamentals - ProLab0_Fundamentals - [ProLab0_Fundamentals.cdf] i O X

File Edit View Processing Tools Window Help

Search altera.com

& Hardware Setup... | |No Hardware Mode: |JTAG X Progress:

[] Enable real-time ISP to allow background programming when available

i Start File Device Checksum Usercode Program/ Verify Blank- Examine Security Erase ISP
: Configure Check Bit CLAMF
i Stop output_files/ProL... 10M50DAF484 0026D2F3 0026D2F3
8 Auto Detec
Delete
™ Add File..
| *Chapge File A
| | Elisave File hameseaas
| ] TOI : :
* Add Device| || ———% b :
Wyp :.........:
10MS0DAF484
'l pawn DO

Fe

Rys. 19: Okno narzedzia Programmer

-10 -



Mechatroniczne Systemy Wykonawcze Sensoryczne i Sterujgce R&M
Lab: Podstawy Quartus Prime Katedes Robotyki s Mechatranik

22. Jesli przycisk Start jest nieaktywny nalezy wybra¢ Hardware Setup... A w oknie, ktdre ukaze sie Currently
selected hardware: USB-Blaster [USB-0].

Jesli przycisk Start jest dalej nieaktywny oznacza to, ze uktad FPGA nie jest wtaczony, nie jest podtaczony od
komputera lub w przypadku korzystania z maszyny wirtualnej fizyczny port usb nie jest zmostkowany z
systemem operacyjnym w maszynie wietualnej. Aby zaptogramowac uktad klikamy na przycisk Start.

» Programmer - E//FPGA/MSWSIS/ProSilnikDC_DE10-Lite_Q18.1/ProDCMotor - ProDCMotor - [ProDCMotor.cdf] &5 O X
File Edit View Processing Tools Window Help Search altera.com
o Hardware Setup... Mode: JTAG T Progress: 100% (Suc(eﬁﬁ-ﬂ)l[i
[] Enable real-time ISP to allow background programming when available
i Start File Device Checksum Usercode Program/ Verify Blank- Examine Security Erase ISP
Configure Check Bit CLAMF
i Stop output_files/ProD... 10M50DAF484 00274270 00274270
Bl auto Detec
Delete
[ Add Fite...
| ™ Change File &
B save File ey
® Add Device| LE b E
Wyp E.........E
10MS0DAF484
' Down e
W

Rys. 20: Okno narzedzia Programmer po zaprogramowaniu uktadu
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